Confidence Intervals for Michaelis-Menten Parameters

Introduction
This routine calculates the sample size necessary to achieve specified widths of the confidence intervals of the parameters of the Michaelis-Menten equation at a stated confidence level. The analysis assumes that the parameters are estimated using maximum likelihood and that the error variance is proportional to the independent variable.

Caution: This procedure assumes that parameter estimates of the future sample will be the same as planning estimates that are specified. If actual estimates are very different from those specified when running this procedure, the interval width may be narrower or wider than specified.

Technical Details

Michaelis-Menten Equation
The formulas used here are found in Raaijmakers (1987). The Michaelis-Menten equation is a well-known model of enzyme kinetics. It is a special arrangement of a two-parameter rectangular hyperbola. The mathematical model is

\[ V = \frac{C(V_{\text{max}})}{C + K_m} \]

where \( V \) is the dependent variable, \( C \) is the independent variable, and \( V_{\text{max}} \) and \( K_m \) are parameters to be estimated. In enzyme kinetics, \( V \) is the velocity (rate) of an enzyme reaction and \( C \) is the substrate concentration. \( V_{\text{max}} \) and \( K_m \) have simple physical interpretations. \( V_{\text{max}} \) is the maximum velocity and serves as a horizontal asymptote. \( K_m \) is the value of \( C \) that results in a velocity of \( V_{\text{max}}/2 \). It is known as the Michaelis constant or ED50.

Estimation
Although several methods have been proposed to estimate the parameters of the Michaelis-Menten equation from a set of data consisting of concentrations and corresponding rates, we will use the method of maximum likelihood because it leads to simple, analytical formulae for the parameters as well as large-sample confidence intervals.

The nonlinear regression model associated with this equation is

\[ V = \frac{C(V_{\text{max}})}{C + K_m} + \epsilon \]
where $\varepsilon$ represents normally distributed errors with zero mean and variance $\sigma^2$. However, this assumption of a constant absolute error is not appropriate in most situations. It is usually more appropriate to assume that $\sigma$ is proportional to the mean value at each value of $C$. This leads to the following statistical model

$$V = \frac{C(V_{\text{max}})}{C + Km} + \left(\frac{C(V_{\text{max}})}{C + Km}\right) \varepsilon$$

If we let $X$ equal $V/C$, Raaijmakers (1987) provided the following estimates of the parameters and their variances.

$$V_{\text{max}} = V + Km \bar{X}$$

$$\hat{Km} = \frac{\bar{X}S_{VV} - \bar{V}S_{XV}}{\bar{V}S_{XX} - \bar{X}S_{XV}}$$

where $S_{VV}$, $S_{XV}$, and $S_{XX}$ are the sum of squares and cross products of the deviations $V - \bar{V}$ and $X - \bar{X}$. $\bar{V}$ and $\bar{X}$ are the sample means of the corresponding variables.

An unbiased estimate of the error variance is given by

$$\hat{\sigma}^2 = \frac{S_{VV} + 2KmS_{XV} + Km^2S_{XX}}{N - 2}$$

where $N$ is the sample size.

The large-sample variances of these estimates are given by

$$\text{var}(\hat{Km}) \approx \frac{\sigma^2}{\left(1 + 2\sigma^2/V_{\text{max}}^2\right) \sum_{i=1}^{N} (U_i - \bar{U})^2}$$

$$\text{var}(\hat{V}_{\text{max}}) \approx \frac{\sigma^2}{N} + \bar{U}^2 \text{var}(\hat{Km})$$

where

$$U_i = \frac{V_{\text{max}}}{C_i + Km}$$

Finally, confidence intervals can be calculated for these estimates based on the normality of the estimates. The $100(1 - \alpha)%$ confidence interval for $Km$ is

$$\hat{Km} \pm z_{1-\alpha/2} \sqrt{\text{var}(\hat{Km})}$$

The $100(1 - \alpha)%$ confidence interval for $V_{\text{max}}$ is

$$\hat{V}_{\text{max}} \pm z_{1-\alpha/2} \sqrt{\text{var}(\hat{V}_{\text{max}})}$$

The widths of these intervals are easily determined.

A close inspection of these formulas will show that they depend on the experimental design. That is, the $C$ values. So the sample size formulae require the specification of a specific design.

**Confidence Level**

The confidence level, $1 - \alpha$, has the following interpretation. If thousands of samples of $n$ items are drawn from a population using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population slope is $1 - \alpha$. 

857-2
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters.

Confidence

Confidence Level (1 – Alpha)

The confidence level, 1 – \( \alpha \), has the following interpretation. If thousands of samples of \( N \) items are drawn from a population using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population slope is 1 – \( \alpha \).

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90 to 0.99 by 0.01.

Number of C Values and Sample Size Allocation

Number of Unique C Values

Select the number of C values in the experimental design. This is the number of unique values of the independent (C) variable. The actual C values are entered in the Experimental Design section below. The possible range of values for this option is 2 to 20.

Since this model includes curvature, at least three C values are needed. We recommend at least five C values to allow a more detailed examination of the nature of the curvature.

Allocation of N to C Values (Solve For = Confidence Interval)

Select the method used to allocate subjects to the various C values. The choices are

**Equal sample sizes for all C values (n = n1 = n2 = ...)**

The sample sizes allocated to each C value are the same. The value of n, the number of subjects at each unique C value, is entered in the n (Sample Size for All C Values) box below.

**Enter base sample size and multipliers for each C value**

The sample sizes at each unique C value are found by multiplying the corresponding Multiplier value (found in the Experimental Design section) times the Base Sample Size value entered in the box below.

**Enter total sample size and a percentage for each C value**

The sample sizes at each unique C value are found by taking the corresponding percentage found in the Experimental Design section of the N (Total Sample Size) value entered below.

**Enter an individual sample size for each C value**

Enter the sample size at each C value directly in the corresponding Sample Size box found in the Experimental Design section below.
Allocation of N to C Values (Solve For = Sample Size)
Select the method used to allocate subjects to the various C values. The choices are

**Equal sample sizes for all C values (n = n1 = n2 = ...)**
The sample sizes allocated to each C value are the same. The optimum total sample size will be found using a binary-search algorithm.

**Enter sample size multipliers for each C value**
The sample sizes at each unique C value are found by multiplying the corresponding Multiplier value (found in the Experimental Design section) times a base sample size value that will be searched for using a binary-search algorithm.

Using this option, you can search for a sample size configuration in which the individual sample sizes are not all equal.

**Enter a sample size percentage for each C value**
The sample sizes at each unique C value are found by taking the corresponding percentage (found in the Experimental Design section) of the N (Total Sample Size) value that will be searched for using a binary-search algorithm.

This options allows you to search for a sample size configuration in which the sample sizes at each C value are not equal.

**n (Sample Size for All C Values)**
Enter the sample size to be used for all C values. The total sample size, N, is the number of C values times this value. The range is one to several thousand. At a minimum, you should have at least two subjects at each C value so that you can measure the pure error variance.

You can enter a single value, such as ‘5’, a list of values, such as ‘2 5 10 50’, or a series of values, such as ‘2 to 20 by 2’. A separate line on the numeric report is generated for each value specified here.

**Base Sample Size**
This is the base sample size for each C value. One or more values, separated by blanks or commas, may be entered. A separate analysis is performed for each value listed here.

The individual samples sizes at each C value are determined by multiplying this value by the corresponding Multiplier value entered in the Experimental Design section. If the Multiplier numbers are represented by m1, m2, m3, ...

and this value is represented by B, the individual sample sizes are calculated as follows:

\[ n_1 = [B(m1)] \]
\[ n_2 = [B(m2)] \]
\[ n_3 = [B(m3)] \]

where the operator, [X] means the next integer after X, e.g. \([3.1]=4\).

For example, suppose there are three groups and the multipliers are set to 1, 2, and 3. If B is 5, the resulting sample sizes will be 5, 10, and 15.

**N (Total Sample Size)**
This is the total sample size of all C values. One or more values, separated by blanks or commas, may be entered. A separate analysis is performed for each value listed here.

The individual samples sizes at each C value are determined by multiplying this value times the corresponding Percent of N value entered in the Experimental Design section. If the Percent values are represented by
p1, p2, p3, ...
and this value is represented by N, the individual sample sizes are calculated as follows:

\[ n_1 = \lfloor N(p_1/100) \rfloor \]
\[ n_2 = \lfloor N(p_2/100) \rfloor \]
\[ n_3 = \lfloor N(p_3/100) \rfloor \]

where the operator, \[ \lfloor X \rfloor \] means the next integer after X, e.g. \[ \lfloor 3.1 \rfloor = 4 \]. If this operation results in a total sample size different from N, various individual sample sizes are reduced or increased by one until the total is N. The change is made to the sample size that is most different from its intended value.

For example, suppose there are three C values and the percentages are set to 25, 25, and 50. If N is 36, the resulting sample sizes will be 9, 9, and 18.

**Parameters**

**Vmax (Maximal Velocity)**
Vmax is a parameter of the Michaelis-Menten equation that represents the maximum reaction velocity (rate). It serves as a horizontal asymptote. It is determined from considering previous studies, a pilot study, or an educated guess. It is in the scale of the dependent variable (reaction rate of velocity).

You may enter a single value or multiple values. The values must be greater than zero.

Enter the maximum that you think the dependent variable (velocity or rate) can be.

**Vmax Confidence Interval Width**
Enter the is the desired width of the confidence interval of Vmax. A binary search will be conducted to find the minimum sample size that will result in this width or narrower.

You may enter a single value or multiple values.

**Km (Michaelis Constant)**
Km is a parameter of the Michael-Menten equation often called the Michaelis constant or ED50. It is in the same scale as the C values. In fact, Km is that C value that results in a velocity of Vmax/2.

You may enter a single value or multiple values. All values should be positive.

**Km Confidence Interval Width**
Enter the desired width of the confidence interval of Km. A binary search will be conducted to find the minimum sample size that will result in this width or narrower.

You may enter a single value or multiple values.

**σ (Error Standard Deviation)**
Enter the anticipated value of the standard deviation of the errors. This value is usually found from a previous experiment or a pilot study. It is in the scale of the velocity (reaction rate).

You may enter a single value or multiple values.
**Experiment Design (C Values and Sample Size Allocation)**

**C Value**
Enter a single C value. This is the anticipated value of the independent variable (substrate concentration) at this position. The experimental design is specified by giving these C values along with the sample size at each point.

**Multiplier**
The sample size allocation Multiplier at this C value is entered here.

If Solve For is equal to **C.I. Width**, the individual sample sizes for each C value are found by multiplying this value by the Base Sample Size value and rounding up to the next whole number.

If Solve For is equal to **Sample Size**, the individual sample sizes are found by multiplying this value by the base sample size that is being searched for and rounding up to the next whole number.

Typical values of this parameter are 0.5, 1, or 2.

**Percent of N**
This is the percentage of the total sample size, N, that is allocated to this C value. The individual samples sizes are determined by multiplying this value times the N (Total Sample Size) value entered above (if Solve For = CI Widths) or the trial value of N (if Solve For = Sample Size).

If these values are represented by p1, p2, p3, ...

the sample sizes are calculated as follows:

\[ n1 = \left\lceil N\left(\frac{p1}{100}\right) \right\rceil \]
\[ n2 = \left\lceil N\left(\frac{p2}{100}\right) \right\rceil \]
\[ n3 = \left\lceil N\left(\frac{p3}{100}\right) \right\rceil \]

where the operator, \(\left\lceil X \right\rceil\) means the next integer after X, e.g. \(\left\lceil 3.1 \right\rceil = 4\).

For example, suppose there are three C values and these percentages are set to 25, 25, and 50. If N is 36, the resulting sample sizes will be 9, 9, and 18.

**Sample Size**
Enter the individual sample size corresponding to this C value. This allows you to enter the individual sample sizes directly.
Example 1 – Calculating Sample Size

Suppose a study is planned in which a researcher wishes to construct 95% confidence intervals for Vmax and Km. Previous studies have found Vmax to range from 20 to 30 and Km to be about 10. The confidence level is set at 0.95. The standard deviation of the residuals estimate, based on the MSE from a similar study, ranges from 10 to 40. The sample size needs to be large enough so that the width of the Vmax confidence interval is 5.

The design is to set the number of C values to 5. The individual C values are 1, 4, 16, 64, and 256.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **Confidence Intervals for Michaelis-Menten Parameters** procedure window by clicking on **Regression**, and then clicking on **Confidence Intervals for Michaelis-Menten Parameters**. You may then make the appropriate entries as listed below, or open **Example 1** by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size using Vmax</td>
<td></td>
</tr>
<tr>
<td>Confidence Level</td>
<td>0.95</td>
<td></td>
</tr>
<tr>
<td>Number of Unique C Values</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Allocation of N to C Values</td>
<td>Equal sample sizes for all C values (n = n1 = n2 = ...)</td>
<td></td>
</tr>
<tr>
<td>Vmax (Maximal Velocity)</td>
<td>20 30</td>
<td></td>
</tr>
<tr>
<td>Vmax Confidence Interval Width</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Km (Michaelis Constant)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>σ (Error Standard Deviation)</td>
<td>10 20 30 40</td>
<td></td>
</tr>
<tr>
<td>C1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>C2</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>C3</td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>C4</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>C5</td>
<td>256</td>
<td></td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Numerical Results</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>C Values: 1, 4, 16, 64, 256</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Row</th>
<th>Conf Level</th>
<th>Sample Size</th>
<th>Total Sample Size</th>
<th>SD of Errors</th>
<th>Maximal Velocity</th>
<th>Vmax SE (Vmax)</th>
<th>Vmax CI Width</th>
<th>Michaelis Constant Km</th>
<th>SE (Km)</th>
<th>Km CI Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.950</td>
<td>135</td>
<td>10.000</td>
<td>20.000</td>
<td>1.261</td>
<td>4.943</td>
<td>10.000</td>
<td>1.056</td>
<td>4.141</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.950</td>
<td>390</td>
<td>20.000</td>
<td>20.000</td>
<td>1.270</td>
<td>4.979</td>
<td>10.000</td>
<td>0.879</td>
<td>3.445</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0.950</td>
<td>730</td>
<td>30.000</td>
<td>20.000</td>
<td>1.272</td>
<td>4.987</td>
<td>10.000</td>
<td>0.712</td>
<td>2.790</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.950</td>
<td>1175</td>
<td>40.000</td>
<td>20.000</td>
<td>1.274</td>
<td>4.992</td>
<td>10.000</td>
<td>0.585</td>
<td>2.292</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0.950</td>
<td>150</td>
<td>10.000</td>
<td>30.000</td>
<td>1.267</td>
<td>4.965</td>
<td>10.000</td>
<td>0.740</td>
<td>2.901</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0.950</td>
<td>470</td>
<td>20.000</td>
<td>30.000</td>
<td>1.275</td>
<td>4.998</td>
<td>10.000</td>
<td>0.673</td>
<td>2.637</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0.950</td>
<td>875</td>
<td>30.000</td>
<td>30.000</td>
<td>1.272</td>
<td>4.986</td>
<td>10.000</td>
<td>0.587</td>
<td>2.300</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>0.950</td>
<td>1355</td>
<td>40.000</td>
<td>30.000</td>
<td>1.275</td>
<td>4.999</td>
<td>10.000</td>
<td>0.510</td>
<td>2.000</td>
<td></td>
</tr>
</tbody>
</table>
Confidence Intervals for Michaelis-Menten Parameters

References

Michaelis-Menten Equation with Variance Proportional to Substrate Concentration
Model: \( V = \frac{V_{\text{max}} C}{K_m + C} + \frac{V_{\text{max}} C}{K_m + C} \varepsilon \)
Dependent variable: \( V \), the reaction rate (velocity).
Independent variable: \( C \), the substrate concentration.
Error variable: \( \varepsilon \), the residual. The model assumes that \( \varepsilon \sim N(0, \sigma^2) \).

Report Definitions
Confidence Level is the proportion of confidence intervals (constructed with this same confidence level) that would contain the true value of the estimated parameters: \( V_{\text{max}} \) or \( K_m \).
\( N \) is the total sample size of the experiment.
\( \sigma \) is standard deviation of \( \varepsilon \) when \( \frac{V_{\text{max}} C}{K_m + C} = 1 \).
\( V_{\text{max}} \) is a planning estimate of the maximum reaction rate (V).
SD(\( V_{\text{max}} \)) is the standard error of the maximum likelihood estimate of \( V_{\text{max}} \).
\( K_m \) is a planning estimate of the Michaelis constant. This is the \( C \) value that yields a \( V \) of \( V_{\text{max}}/2 \). It is sometimes called ED50.
SD(\( K_m \)) is the standard error of the maximum likelihood estimate of \( K_m \).
\( K_m \) CI Width is the width of the confidence interval of \( K_m \).

Summary Statements
A sample size of 135 subjects results in a width of 4.943 for a two-sided, 95% confidence interval of \( V_{\text{max}} \) and a width of 4.141 for a two-sided, 95% confidence interval of \( K_m \). The planning estimates are 20.000 for \( V_{\text{max}} \), 10.000 for \( K_m \), and 10.00 for \( \sigma \). The experiment design is sample sizes of 27, 27, 27, 27, 27 corresponding to \( S \) values of 1, 4, 16, 64, 256.

This report shows the calculated sample size for each of the scenarios.

Design Details for Row 1

<table>
<thead>
<tr>
<th>C Level</th>
<th>C</th>
<th>n</th>
<th>Pct of N</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>1.0</td>
<td>27</td>
<td>20.0</td>
</tr>
<tr>
<td>C2</td>
<td>4.0</td>
<td>27</td>
<td>20.0</td>
</tr>
<tr>
<td>C3</td>
<td>16.0</td>
<td>27</td>
<td>20.0</td>
</tr>
<tr>
<td>C4</td>
<td>64.0</td>
<td>27</td>
<td>20.0</td>
</tr>
<tr>
<td>C5</td>
<td>256.0</td>
<td>27</td>
<td>20.0</td>
</tr>
</tbody>
</table>

This report shows how the 135 subject are allocated to the various C values. In this case, 27 subjects are allocated to each of the five C values.
Plots Section

These plots show how the necessary sample size changes for variance values of the error standard deviation and Vmax.
Example 2 – Validation using Raaijmakers

Raaijmakers (1987) page 798 gives an in which a researcher wishes to construct 95% confidence intervals for Vmax and Km. The design is to set the number of C values to 5. The individual C values are 1, 4, 16, 64, and 256. Previous studies have found Vmax be 25 and Km to be 10. The confidence level is set at 0.95. The standard deviation of the residuals is estimated at 6.25. The sample sizes of 5, 10, and 20 result in SE(Vmax) values of 4.444, 3.143, and 2.222 and SE(Km) of 3.169, 2.241, and 1.585. The confidence interval widths are easily calculated from these standard errors.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for Michaelis-Menten Parameters procedure window by clicking on Regression, and then clicking on Confidence Intervals for Michaelis-Menten Parameters. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
**Design Tab**
Solve For | CI Widths of Vmax and Km
Confidence Level | 0.95
Number of Unique C Values | 5
Allocation of N to C Values | Equal sample sizes for all C values (n = n1 = n2 = …)
N (Sample Size for All C Values) | 1 2 4
Vmax (Maximal Velocity) | 25
Km (Michaelis Constant) | 10
σ (Error Standard Deviation) | 6.25
C1 | ...
C2 | ...
C3 | ...
C4 | ...
C5 | ...

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Row</th>
<th>Conf Level</th>
<th>Sample Size</th>
<th>N</th>
<th>SD of Errors</th>
<th>Maximal Velocity</th>
<th>SE(Vmax)</th>
<th>Vmax</th>
<th>Michaelis Constant</th>
<th>SE(Km)</th>
<th>Km</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.950</td>
<td>5</td>
<td>5</td>
<td>6.250</td>
<td>25.000</td>
<td>4.444</td>
<td>17.422</td>
<td>10.000</td>
<td>3.169</td>
<td>12.423</td>
</tr>
<tr>
<td>2</td>
<td>0.950</td>
<td>10</td>
<td>10</td>
<td>6.250</td>
<td>25.000</td>
<td>3.143</td>
<td>12.319</td>
<td>10.000</td>
<td>2.241</td>
<td>8.784</td>
</tr>
<tr>
<td>3</td>
<td>0.950</td>
<td>20</td>
<td>20</td>
<td>6.250</td>
<td>25.000</td>
<td>2.222</td>
<td>8.711</td>
<td>10.000</td>
<td>1.585</td>
<td>6.211</td>
</tr>
</tbody>
</table>

PASS matches these standard errors exactly. Note that the confidence interval width is 4.444 x 1.96 x 2 = 17.42 which matches PASS’s result within rounding.